
1 ProSail 

ProSail 4 

headsail/mainsail/gennaker/gaff/patches/patternMaker/Mitre 

 

Manual 

 

 

Armstrong-White Automation (NZ) Ltd 

 

© Armstrong-White Automation (NZ) Ltd 

22 Kereru Grove, Greenhithe, Auckland 0632, New Zealand. 

tel +64 9 413-7642 

info@prosailcutter.com 

www.prosailcutter.com 

July 2017 



2 ProSail 

Dongle 

 

 

    

 

 A dongle is a small USB connector that plugs into a USB port on your computer.  

For many ProSail machines, a dongle is required for the software to run. 

Licence Agreement 

This is a legal agreement between you, the end user, and Armstrong-White 

Automation (NZ) Ltd.  This software is owned exclusively by Armstrong-White 

Automation (NZ) Ltd.  Armstrong-White Automation (NZ) Ltd grants you the 

right to use this software by way of this licence agreement.  It is important to 

note that if you loose the software, it will be replaced free of charge.  However, 

if you loose the dongle (or serial converter) which protects this software, you 

have lost your entire software licence.  Hence it is recommended that the dongle 

(or serial converter) be insured for the full replacement cost of this software 

licence.  If however the dongle (or serial converter) is only damaged, it will be 

replaced in exchange for the damaged one for no more than the material cost. 

Disclaimer 

 Armstrong-White Automation (NZ) Ltd is not liable or responsible to the 

purchaser or user for loss or damage caused, or alleged to be caused, directly or 

indirectly by the software or hardware and its attendant documention, including 

(but not limited to) interruption of service, loss of business, or anticipatory 

profits. 

USB to Serial converter 

 

    

 

    

 

  With the ProSail plotter mkIII or the ProSail digitiser, the dongle is an optional 

extra and is not supplied as standard.  With these machines the software will 

run so long as the USB cable from the “USB to Serial converter” is plugged into 

the computer (the machine does not need to be turned on, just the USB cable 

plugged in to the computer). 
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Introduction 

There are three main steps to designing a sail : 

1) Generate a Mould : 

 (i) Dimensions from the Mould menu : Specify luff, foot, leech etc. 

 (ii) Shaping from the Mould menu : Specify mast-bend, depth, twist etc.  Some of 

these curves can also be modified in the Chord window but the Shaping window is 

the best place because it allows you to fair these curves vertically up the sail. 

 (iii) Battens from the Mould menu.  Some girths can also be enforced in this 

window. 

2) Generate Panels over the Mould : 

 (i) New or Open from the Panel menu : Specify the panel layout. 

 (ii) Eyelets/2-Ply from the Panel menu. 

 (iii) Patches from the Window menu. 

 (iv) Colour Panels from the Window menu.  Colour the panels to indentify fabric. 

3) Production : 

 Nesting from the Window menu : Send the panels to the Nesting window for 

nesting and driving a plotter or cutter. 

When starting to use ProSail you probably won’t know exactly how much % depth etc to 

put into your designs.   Instead you will know how much shape you want in your panels.  

However with mould design programs it is not possible to directly enter your panel 

shapes and get a mould as a result. 

Hence initially you will need to put a mould design in (start with one of the sample 

designs), get ProSail to develop it into panels and then go to Panels from the Window 

menu to see what panels have been produced.  You can then modify the mould shape in 

order to produce the panel shapes you want. 

The most important curve to modify to get the shapes you want is the Depth curve.  The 

chapter titled “Shaping” has a section on the Depth curve and how the curvature of the 

depth curve largely determines the shape in the panels. 

Getting started : 
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Units 

Units from the File menu : 

This dialogue determines the current units and decimal places displayed in all of the dialogues 

throughout the program. 

Although numbers will be displayed in these units they can be entered in any of the above 

units.  For example if you want to enter 1.5 feet into a dialogue, you can enter 1.5f or 1.5’ or 

1f6i or 1’6”.   Then after pressing the Enter key it will be converted to the current units you 

selected in the Units dialogue. e.g. 457.2mm 

If the current field is already displayed in the units that you want then when you enter a new 

number there is no need to add the units letters after the number.  Just type the number. 

Most dialogues have a % button that toggles between % and the current unit when you click in 

it. 

If for example mm is displayed in the % button then fields in the dialogue will be displayed in 

mm. 

If however %  is displayed in the % button then some fields will be displayed as a %.  Then if 

you enter a number into these fields it will be assumed to be a % unless you add the units 

letters to the end of the number. 

Some examples 

   entered   converted 

   4.2f    1280.2mm 

   1.4m    1400.0mm 

   4.2f - 7mm  1273.2mm 

   10i    254mm 

   100+10.7   110.7mm 
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You can view your sail as a 3D “wire frame” or as a “solid rendering”.  

To switch between wire frame and solid rendering click the icon on the left of the screen. 

Viewing 

The view direction can be changed by dragging any of the 3 scroll bars around. 

An easier way to change the view direction is with the Animate feature.  Select Animate from 

the View menu (or click the “F1” key on the keyboard, or right click the mouse and click on 

Animate.  A square outline will appear on the screen.  As soon as the mouse enters the square 

the animate feature is activated.  By moving the mouse from side to side and up or down you 

can rotate the view. 

Clicking the small square at the bottom left of the screen will show the plan view. 

There are two animation modes when moving the mouse horizontally.  It will either rotate the 

view in a horizontal plane or it will tilt the view clockwise/anticlockwise.  To toggle between 

these 2 modes, press and release the Ctrl key on the keyboard while animating.   This will 

redisplay the square outline.  After moving the mouse into this square again, the mode will 

have changed.  

To deactivate animation, click the mouse anywhere on the screen. 
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Light from :  Click on this to animate the direction of the light source.   Works in a 

similar way to animating the view except it displays 2 arrows indicating 

the direction of the light source.  The arrows are largest when pointing 

directly into the screen and change colour when at 90 degrees to this 

direction. 

 There are actually 2 light sources - one directly in front which is fixed 

and another one that you can change the direction of using Light 

from. 

toolbox :  Displays the lighting toolbox.  See next page. 

View1, View1, View3, View4, View5 : Click on one of these to go to that stored 

view.  A quicker way is to use the “F2” key on the keyboard to loop 

through the different views you have stored.  

Store View :  Up to 5 different views including different light settings for each can be 

stored.  Click Store View and select one of the 5 views to store the 

current view. 

The maximum rotation of the view (either 180 or 360 degrees) is set in preferences from the 

File menu : scroll bars 360 degrees. 

Right clicking the mouse on 

the screen will display this 

popup menu : 

Displays the surface mould with minimal number of lines. 

Displays the surface mould with a large number of lines. 

Displays the panels that have been generated. 

Displays the panels that have been generated showing development lines. 

Viewing 
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Ambient:  Changes the intensity of ambient light. 

Transparent:  Changes the level of transparency of the surface. 

Color:  Changes surface color. 

Back:  Changes the background color. 

Default Light: Changes color, light direction, ambient and transparent to the 

default values. 

Zoom view 

To zoom into part of the surface, hold down the Ctrl key on the keyboard and with it still 

held down press and release the Z key on the keyboard.   Then release the Ctrl key.  A 

horizontal and vertical line will be displayed at the mouse location.  Move the mouse to 

the area you want to zoom in on.  Click and hold down the left mouse button and drag the 

resulting selection box to encompass the area you want zoomed.  When the mouse button 

is released, the selection box will be zoomed to fill the entire window.   

If viewing the surface as a solid render, you are able to animate the view while it is 

zoomed.  The point on the surface at the centre of the window will remain at the centre as 

you animate. 

To unzoom, click on any of these icons :  

 

Note: there are two modes when dragging the selection box.  Either the click of the mouse 

will correspond to one corner of the selection box or the click will correspond to the centre 

of the selection box.  To swap between these two modes, press and release the Ctrl key 

while the selection box is visible. 

Toolbox 

Viewing 
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Viewing 

Preferences from the File menu : 

Always use preferences in c:\prosailw : Throughout ProSail you will specify various 

preferences.  These are all stored in a file called untitled.psw.  Normally ProSail is run 

from the C:\prosailw folder and it will use the untitled.psw file in that folder.   

However when you run ProSail by double clicking on one of its files (for example a plt 

file) that is stored somewhere else, it will create a new untitled.psw preferences file 

inside the folder that the plt file is in unless  always use preferences in 

c:\prosailw is ticked in the above window.   

 It can be useful to have different preferences for different locations.  However 

normally you will just want one preferences file and so it is recommended that you 

have always use preferences in c:\prosailw ticked in the above window. 

 

Always start program in full screen : At startup the main viewing window will always 

start in full screen if always start program in full screen is ticked.  If the viewing 

window becomes too large and overlaps the Microsoft windows taskbar at the bottom 

of the screen you can fix this by : 

Right clicking the mouse on the taskbar and select “properties”. 

Make sure the “taskbar” tab is selected and then tick “keep the taskbar on top of 

other windows”.  

 Batten, Girth, Eyelet and all Panel windows can also be zoomed to full screen by 

double clicking on their title bar.  This will be remembered the next time you start 

ProSail and is independent of the always start program in full screen setting. 

 

Scroll bars 360 degrees: Optionally viewing range can be the current 180 degrees or 

the new 360 degrees.  360 degrees is useful if animating. 
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Dimensions 

Select Dimensions from the Mould menu : 

Mainsails 

Luff, Head-Clew and Foot lengths are measured over the sail mould.  These are the same 

measurements obtained by laying the sail on the floor and pulling it tight between the head, 

tack and clew. 

If selected, the Head-Clew length must be entered. 

If selected, Boom droop must be entered.  Note that ProSail draws the 3D sail so 

the mast at the tack is vertical.  A Boom droop of zero does not mean the tack 

angle is exactly 90 degrees as measured flat on the floor.  Boom droop can 

optionally be expressed as a % of the Foot length.  Boom droop can be entered 

as a -ve number to bring the clew above the tack. 

Head angle : This angle can be between 80 and 100 degrees.  (If the Gaff module is 

present, there is no restriction to this angle).   Note : some older versions of ProSail will only 

be able to read files with a head angle of 90. 
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Dimensions 

Headsails 

ProSail uses I and J as defined in the diagram above where J is measured back from the 

tack point and I is measured at 90 degrees to this.   If you are simply defining the sail 

using Luff, Foot and Head-Clew lengths, the values you enter for I and J are not used.  

They simply rotate the sail for viewing purposes. 

 

ProSail uses Pythagoras on I and J to work out the Hypotenuse.  Hence so long as the 

correct I and  J measurements have been entered, the Luff length can optionally be 

expressed as a % of this length. 

If selected, Foot length must be entered. 

If selected, LP length must be entered.  So long as the correct J measurement has 

been entered, LP can be expressed as a % of J. 

If selected, Head-Clew length must be entered. 

If selected, Clew up distance must be entered.  Note that this is based on the 

triangle formed by I and J. 
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Dimensions 

Gennaker (Extra Module) 

If selected, the Luff length you enter is taken as being the 3D straight line length 

as shown on the diagrams as luff 2.  Note that this is not the length around the 

luff. 

If selected, the Luff length you enter is the actual luff length measured around the 

luff as shown on the diagrams as luff 1.  This is the most common method.  

If selected, Leech length must be entered.   This is the actual length around the 

leech.   Hence it is not the same as the head-clew length used for mains or jibs.  

If selected, Clew up distance must be entered.  Note that this depends on the 

triangle formed by I and J. 
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Dimensions 

Gaff (Extra Module) 

This variable is very important and determines the direction of the chord 

shaping for the sail.   

If the Gaff Angle is small, then the sail should be defined as a  High Aspect Ratio sail 

so the chord shaping will be parallel with the foot as per conventional mainsails. 

If the Gaff Angle is large, then the sail should not have High Aspect Ratio selected 

and so the chords will fan from the foot to the head.   In that case the depth of the 

chord at the head should be set to zero. 

High Aspect Ratio 

If selected, a Gaff Angle must be entered.  Otherwise a Leech length 

must be entered. 

Head Angle 

If selected, a Foot Angle must be entered.  Otherwise a Diagonal length 

must be entered. 

Foot Angle 

Low Aspect  High Aspect  
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Shaping 

Select Shaping from the Mould menu to display the shaping dialogue : 

The shaping dialogue displays all of the curves that define the sail mould except roach.  

With the exception of foot-round and gaff-bend, all of these curves are considered 

vertically up the sail.  For example with the mast-bend, the left of the shaping dialogue 

corresponds to the base of the luff (tack), and the right corresponds to the top of the luff 

(head). 

To view a different curve, click the mouse in the icon corresponding to that curve. 

To select an Adjustment Point, click anywhere above the Adjustment Point (but not too 

close to the point or you may move it).  You do not need to be very close.  Near the top 

of the window will do.  Alternatively, use the left or right arrow keys on the keyboard.  

When selected, a red arrow indicates the selected Adjustment Point and the X and Y 

values are displayed for that point.  X being the distance along the curve (height up the 

sail) and Y being the value of the curve. 

Adjustment points 
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Shaping 

Visually scales the curves up or down.   This is only a visual effect to aid 

fairing and has no effect on the actual size of the curves. 

To add an Adjustment Point, click on Add, release the mouse and position 

the resulting vertical line at the desired horizontal location before clicking the 

mouse. 

Deletes the currently selected Adjustment Point. 

There are three ways to move an Adjustment Point : 

 

(i) Click on an Adjustment Point (you need to click very close) and with the mouse 

button still down, drag it to the required location and release the mouse button.  

If move-2D is currently selected, X is changed also, otherwise only Y is 

changed.  If scale is currently selected, all the Adjustment Points will move in 

proportion.  This is useful for scaling the entire shape up or down. 

 

(ii) Click on the red arrow and drag it horizontally to change X.  Y will also change so 

the curve remains the same shape. 

 

(iii) Type the desired X or Y value using the keyboard.  Then press either the Enter or 

Tab key on the keyboard to see the result.  Enter keeps you in the same field, 

Tab takes you to the next one. 

Goes to the Chord window.  See chapter titled Viewing. 

Goes to the Girth window.  See chapter titled Girths. 
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Shaping 

Depth. 

Position of Depth. 

3D Mast-bend. 

Twist. 

Transverse Mast-bend. (Only available if Gennaker module present) 

Foot Round. 

3D Leech Hollow. 

Forestay-sag. 

Forward Depth. 

Aft Depth. 

3D Mast-bend that changes Depth. 

Gaff-bend. (Only available if Gaff module present) 

Forward Position (visible if selected in the Preferences from the Window menu) 

Aft Position (visible if selected in the Preferences from the Window menu) 

Forward B-Spline control points. 

Aft B-Spline control points. 
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Shaping 

3D Mast-bend 

The shape of the actual mast measured from a line between the tack and the head. 

Note : The mast-bend is not the same as the 2D Luff round you measure on the floor.  It is the 

actual shape of the mast when the sail is flying. 

The cross-sectional shape of the sail (chord) would look like the following where Y is the mast-

bend at height X : 
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Shaping 

Click on this button to display the 2D Luff round/hollow that you measure on 

the floor. 

There are two ways to measure luff round/hollow : 

(i) Fanned (sometimes called flaked or folded) method where the sail is pulled tight 

between the tack and the head with the sail folded a short distance back from the luff.   

The rest of the sail is loose.   This is probably the most common method of measuring 

luff round but it does vary a great deal depending upon such things as how tight it is 

pulled, stretch in the fabric and how far back from the luff the fold is made.   ProSail 

uses a fold going from 10% along the foot to the headboard itself : 

(ii) Flattened method where the cross-cut panels of the sail are laid together before 

sticking or sewing.   Its also the same as a finished sail where all of the shape in the sail 

is flattened by pulling the luff and leech apart at intervals up the sail : 

Click on this button to display the 2D Leech round/hollow that you measure 

on the floor.  Note that this is different from the roach in the batten dialogue 

since it is measured from the back of the headboard.  

To change the method (fanned or flattened) you wish to see, select 

Preferences from the Window menu : 



19 ProSail 

Shaping 

Depth 

Two curves are drawn for the depth display.  Both curves relate to the depth vertically up the 

sail.  The left of the screen corresponds to just below the foot of the sail, the right corresponds 

to the head. 

The lower curve is the physical depth curve.  This is physically what you see on the 3D sail 

when it is flying. (You need to imagine the sail is heeling over 90 degrees)  The upper curve is 

the %Depth curve.  This is a graph of the depth in the sail drawn as a % of the width (chord 

length) of the sail at points up the sail.   

At any height up the sail, the value of the %Depth is calculated as follows : 

%Depth = Depth / Chord Length as % 

One way of looking at these two curves is that the physical depth curve is what you see, 

whereas the %Depth curve is what the airflow sees. 

Note : the %Depth in the head is not zero.  Of course the physical depth is very close to zero 

because the chord length is small, but the %Depth should not be set to zero since it makes 

fairing the %Depth curve difficult. 
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Shaping 

zero foot round line 

Note : The actual depth curve is drawn 5% below the tack height (i.e. below X = 0).  The 

reason for this is because of foot round, it is possible for the sail to extend below the straight 

tack to clew line.   In fact even with zero foot round, the foot panel usually extends below this 

line.   This zero foot round line is drawn on the actual depth curve : 

The most important factor determining the amount of shape a mould program will generate in 

the sail panels is the amount of curvature in the physical depth.  The more curvature in the 

physical depth curve, the more shape there will be in the panels.  It is not the actual value of 

depth that is important.  It is the change in depth as you go from the foot to the head.  

Consider the following Depth shaping curves : 

Not much curvature anywhere in this sail.  

Hence the sail will be fairly flat.  Could 

increase curvature by reducing the depth 

at the foot. 

High curvature 

here.  Hence a lot 

of shape in the 

lower part of the 

sail. 

Not much curvature here.  Hence 

little shape in the rest of the sail. 

Large amount of curvature everywhere in 

this sail.  Hence the sail will be fairly full. 

X = 0 
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Shaping 

For the % Depth curve, if highly shaped is selected, the lower section of the depth curve can 

be highly shaped without affecting the rest of the depth curve.  Use this option when you 

require more shape in the panels in the foot area.  In addition to the depth adjustment points, 

a lever is used.  To move the lever, either drag its end point or type an angle through the 

keyboard.  To select the lever, click anywhere on the lever (not necessarily the end of the 

lever). 

Notice the physical depth curve extends (5%) below the foot chord.   Although the mould as 

seen on the 3D view of the sail starts from the foot chord, the panels generated on the sail 

usually extend below this chord even if zero foot round is specified.  Hence it is useful to see 

the depth of the sail below the foot chord. 

The small line drawn from the foot chord to 90 degrees with the absolute depth curve is an 

approximate location for zero foot round. 

If you want to directly control the shape of the depth below the foot curve, you can drag the 

foot chord down to 5% below the foot by clicking on the red arrow below the foot chord and 

dragging it to the left.  
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Shaping 

Position of Depth 

The Position of Depth curve is a graph of the % position of depth in the sail going from the foot 

of the sail (at the left of the screen) to the head of the sail (at the right of the screen).  At a 

given height up the sail, the cross-sectional (chord) shape would be as follows : 

As with other curves as many adjustment points as desired can be added to the shaping curve.  

However since this curve is fairly flat, usually it is sufficient just to have one point at the foot 

and one at the head as in the above example with the position changing slightly from the foot 

to the head. 

% Pos. Depth = Pos. Depth / Chord Length as % 
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Shaping 

Twist 

The twist curve is a graph of the angle of twist in the sail going from the foot of the sail (at the 

left of the screen) to the head of the sail (at the right of the screen).  At a given height up the 

sail, the cross-sectional (chord) shape would be as follows : 

There are two curves drawn : The top curve is the angle of twist in the sail, the bottom curve is 

the effect of the twist on the leech as seen from aft of the boat.  As with other curves as many 

adjustment points as desired can be added to the shaping curve.  However most people find it 

sufficient just to specify a value of twist (between 5 and 15 degrees. More for a #1 than a #3) 

at the head and to have the twist increase in a linear fashion from the foot to the head as in 

the above example. 

Because twist pushes the sail out, it also slightly increases the curvature in the physical depth 

of the sail.  As explained earlier regarding the depth curve : The more curvature in the physical 

depth curve, the more shape in the panels.  Hence increasing twist will slightly increase the 

panel shaping in the sail.  In a similar way, increasing Mast-Bend and Roach will increase the 

shaping in the sail.  Of course Mast-Bend also has the greater effect of increasing Luff Round. 
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Shaping 

% Forward Depth % Aft Depth 

The Forward and Aft Depth curves are a graph of the forward and aft depths in the sail going 

from the foot of the sail (at the left of the screen) to the head of the sail (at the right of the 

screen).  At a given height up the sail, the cross-sectional (chord) shape would be as follows : 

If we take for example the Forward Depth : At a given height up the sail, it is expressed as a % 

of the maximum Depth at that height.  The Forward Depth shaping curve is hence a curve that 

defines how the Forward Depth changes as a % of the maximum depth as we go up the sail.  If 

the forward depth curve is totally straight and horizontal (which in most cases is sufficient), the 

Forward Depth in the sail will be exactly the same % of the maximum depth all the way up the 

sail.  The maximum depth will of course change going up the sail, but the Forward Depth will 

change with it.  To flatten the Entry of the chords for example, reduce the % Forward Depth 

curve. 

The position of these Forward and Aft depths is described on the next page. 

The Aft Depth is similarly expressed as a % of the maximum Depth. 
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Shaping 

Forward Position Aft Position 

These control the position of the forward depth and aft depth.   See also the Chord 

chapter.   

If these curves are 0%, the position of the forward depth is half way between the luff and 

max. depth position and the position of the aft depth is half way between the max. depth 

position and leech. 

If these curves are 100%, the the position of the forward depth is 75% of the distance 

between the luff and max. depth position and the position of the aft depth is 75% of the 

distance between the max. depth position and leech. 

 

Increasing either of these curves will push the position of forward or aft depths away from 

the max. depth position. 

With these curves it is possible to make chord shapes that are more Frisbee like.   This is 

sometimes useful for gennakers.  However for most sails it is sufficient just to set them to 

zero.  If even more control is required, the B-Spline chords (next page) will offer this. 

To display the Forward and Aft Position icons, select Adjust extra depth positions in the 

Preferences dialogue from the Window menu. 



26 ProSail 

These B-Spline icons are an alternative to the Standard Fore and Aft Depth/Position icons.  

See the Chord chapter for an explanation of  “Standard” chords and “B-Spline” chords. 

B-Spline chords 

Shaping 
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Shaping 

3D Leech Hollow 

Forestay-sag 

Forestay-sag is the displacement of the chord in a direction tangential to the entry of the 

chord.  If you compare this curve with the 2D Luff Hollow displayed in the Fanned mode, 

they are very close to each other.  If looking directly down the Forestay from head to 

tack, a typical chord in cross-section would look as follows : 

The 3D Leech Hollow curve is the amount of 3D hollow cut 

into the leech when looking side on at the 3D sail.  It will 

not be exactly the same as the 2D Leech Hollow curve as 

seen on the sail laid flat on the floor. 

Note that this icon is not available if the sail has battens 

since the Battens dialogue has its own way of defining 

hollow between the battens.   Hence to see this icon in the 

shaping window, you need to remove all battens first. 
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Shaping 

Transverse Mast-bend (Only available if Gennaker module present) 

Transverse Mast-Bend is sideways mast-bend.  It is only available if the Gennaker 

module is present.   If looking directly down the luff from head to tack of a Gennaker, a 

typical chord in cross-section would look as follows : 

ProSail treats a Gennaker as if it is a mainsail with a large mast-bend and a large 

transverse mast-bend.  You also need a large leech round which can be done by 

specifying a large -ve 3D leech hollow. 

 

For some Gennakers, there are girth restrictions and so it may be necessary to go to the 

Girths dialogue (there is a Girths button in the Shaping window) to see the girths. 

 

Once happy with the shape and girths, the next step is to look at the 2D luff round by 

clicking on the Luff Round button in the shaping window.  Most designers know what 

they want in terms of the 2D fanned luff , usually a small hollow.  By increasing the 

Transverse Mast-Bend curve, and then looking at the resulting 2D Luff Round, it will be 

reduced.  Similarly it will be necessary to look at the 2D fanned leech. 

 

In general, increasing the the Mast-Bend curve will increase the 2D luff round.  

However, increasing the Transverse Mast-Bend will decrease the 2D luff round.  Hence 

the two curves compete against each other. 

Gennakers 
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3D Mast-bend that changes Depth. 

Gaff-bend. 

Foot Round 

This is the 2D shape placed on the bottom of the foot panel.  The left of the screen 

corresponds to the tack, the right to the clew. 

This is the amount of bend in the Gaff of a Gaff sail.  The left of the screen corresponds 

to the luff, the right to the leech. 

This is exactly the same curve as the 3D Mast Bend explained near the beginning of this 

chapter.   The difference being that when you change this curve, the depth curve will 

change in order to keep the girths around the chords the same.  For example, if you 

increase this curve, the depth in the sail will reduce. 

However, these girths are only done at certain points up the sail.   Namely they are at 

the same locations as the Adjustment Points on the Depth curve.  Hence before using 

this method of changing Mast-Bend, you need to make sure you have several Adjustment 

points on the Depth curve. 

Because this is the only curve in ProSail which directly changes another curve (all other 

curves are independent) please use it with care.  This icon is usually hidden to prevent it 

being clicked on accidentally.   To display this icon, select Preferences from the 

Window menu and tick Use mast-bend that changes depth. 

Shaping 
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Chords 

Select Chords from the Window menu to see cross-sectional shapes (chords) up the sail : 

% height up the sail. 

Scroll bar displays 

chords at 5% 

intervals up the sail. 

Mid Depth is the maximum depth of the chord and is displayed as a % of chord length. 

Mid Position is the position of maximum depth. 

Fore position is the position where the Fore Depth is measured and is displayed as a 

% of the position of maximum depth.  Hence 50% is half way between the luff and the 

position of maximum depth. 

Aft Position is measured as a % of the distance between the position of maximum 

depth and the leech.  Hence 50% is half way between the position of maximum depth 

and the leech. 

Fore and Aft Depths are the depths at the Fore and Aft Positions expressed as a % 

of the Mid Depth. 

Fore and Aft angles correspond to the Entry and Exit angles.  Mid. angle is the Twist. 
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NOTE : Dragging a control point on the currently displayed chord will change the shape 

of the chord at the current height up the sail.  However it is important to relate this 

height back to your placement of adjustment points on the various curves making up 

the sail in the shaping window.   For example if you try to move the depth control point 

on a chord at 60% height but you don't have an adjustment point on the depth curve in 

the shaping window within 25% of this height, ProSail will add an adjustment point for 

you in the shaping window.   However you will be prompted before it does this.  

Chords 

There are 2 types of chords in ProSail : “Standard” Chords and “B-Spline” Chords.  “Standard” 

chords are quick and easy to use.   “B-Spline” chords give more control if that is required.  The 

type used for a particular sail is specified when creating a new sail : New from the File menu : 

Both “Standard” Chords and “B-Spline” Chords have control points that you can adjust 

in the chord window and will change the corresponding curves in the shaping window. 

To see these red control points, click the mouse anywhere in the view : 
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Standard Chords have up to 6 control points. 

The lower middle control point controls the position of max. depth, the upper middle 

controls the max. depth. 

The upper left and right control the forward depth and aft depth respectively. 

The bottom left and right (if they are visible) control the fore and aft depth position 

curves respectively.  If these are not visible, tick Adjust extra depth positions in 

Preferences from the Window menu in the Shaping window. 

 

Standard Chords : 

Chords 
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B-Spline chords have 8 control points. 

The lower middle control point controls the position of max. depth, the upper middle 

controls the max. depth. 

The other control points do not lay on the chord itself but they influence it. 

B-Spline Chords : 

Chords 
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Show All If selected, chords will be drawn superimposed at 20% intervals.  If not 

selected, chords will be displayed individually at 5% intervals and their size 

scaled to fit inside the window. 

Will display the following dialogue where you can specify either sheeting 

Angle or distance From C/L.  If distance From C/L is entered, ProSail will 

calculate the sheeting Angle for you.  If at a later date, foot length for 

example is changed, the sheeting Angle will remain the same but the 

distance From C/L will change.  As well as rotating the view in the chords 

window, it also changes the view in the 3D viewing window.  However, it has 

no effect on the shape of the panels generated and is only a visual effect 

especially useful for looking at Entry and Exit angles : 

Chords 
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Battens 

Select Battens from the Mould menu : 

The operation of the batten dialogue is closely related to the operation of the shaping dialogue.  

The data displayed corresponds to the batten drawn with a circle next to it.   To select another 

batten click the mouse near it. 

The roach curve specified in this dialogue is added to the mould to form a smooth leech.  At the 

start of panel development, this smooth leech is trimmed to give the specified hollow between 

the battens. 

These two icons change the display of the roach curve so it is drawn either 

as a curve or straight between battens.  Note that this has no effect on the 

form of the leech and is solely for viewing purposes in this window.  The 

form of the leech between the battens is determined by the hollow icon. 
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Battens 

front of head back of head 

NOTE : Some older versions of ProSail will not be able to read files where roach is 

specified from back of head. 

When swapping between back of head and front of head, the batten locations on 

the leech are changed and hence the sail will have changed.  The amount of change 

will depend upon the size of the headboard. 

Roach can be specified either from the front of the head or from the back of the head. 
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Makes the current batten a full length batten.  The batten length will be 

displayed and will change as you change the sail shape.  e.g. by changing 

the roach. 

Adds another batten.  Click Add and then click where you want the batten 

to go. 

Displays a dialogue allowing insertion of evenly spaced 90 degree battens.  

If four battens are specified, their lengths will be based on E as governed 

by the IMS rules.  By default, E is set to the foot length.  If the foot length 

is later changed, E and the batten lengths will be changed in proportion. 

Deletes the currently selected batten. 

Displays the Girths dialogue for folding method.   See folding method. 

Displays the IMS calculations used by this version of ProSail in the Girths 

dialogue. 

Visually scales the roach up or down.   This is only a visual effect to aid 

fairing and has no effect on the actual size of the roach.  To directly scale 

the roach curve, use the scale check box. 

Displays a dialogue asking for the position of the backstay so it can be 

drawn in the batten window.  Its position is specified by the distance 

directly aft from the front (or back if roach from back is used) of the 

headboard and directly aft from the clew. 

Battens 

Displays the Girths dialogue for point to point method.   See point method. 
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Hollow between battens icon.  In this mode you can individually specify the 

hollow between each set of battens.   This can be expressed in absolute units 

or as a % of the length between the battens.  Note that this needs to be 

specified individually for each set of battens.  To select another set of battens, 

click the mouse between them. 

If smooth roach is selected, the leech will be a smooth curve exactly the same 

as it would be if -ve leech hollow was specified in the shaping window. 

Battens 
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Select Girths from the Window menu. 

Girths 

There are two windows for calculating the girths across the sail depending upon the method 

you are using to measure these girths. 

Point to Point Method : If you simply want the girth measured from a specified point on the 

luff to a specified point on the leech then select Girths from the Window menu or the Girths 

button in the Shaping window to display the following : 

Note that this method does not involve folding the sail but simply specifying a distance down 

the luff from the front of the headboard and around the actual leech from the back of the 

headboard.   There are three locations that can be specified. 

Additionally the vertical girth running from the middle of the foot to the head is also displayed.  

However, care must be taken when looking at this figure since it is only the girth measured 

over the mould.  Although it includes the foot round, it does not make any allowance for the 

panel layout you are going to use.  By placing panels over the mould, you are in effect reducing 

the size of the sail slightly because the panels lie inside the mould.  For horizontal girths this is 

only a small reduction, however for vertical girths, this could be quite significant depending 

upon the panel layout and how many panels there are.  You can see this effect if you view the 

cross-cut panelled sail from below showing Panel Development Lines (see Viewing chapter) and 

look at the foot area.  Notice how the panels are rather jagged.  Although the panel seams lie 

on the mould, the middle of the panels lie inside the mould.  This is necessary to develop a 

mould into panels. 

Min.  Is minimum distance to luff. 
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Girths 

Folding Method  : If you want to measure girths by folding the sail, go to the Batten window 

and click on the Girths button to display the following : 

Note : Although IMS terms are used in this dailogue, the sail does not need to be an IMS sail to 

use the folding method. 

MGM : Maximum Girth Middle : The leech position for MGM is obtained by folding the front of 

the headboard to the clew.  

MGU : Maximum Girth Upper : The leech position for MGU is obtained by folding the front of 

the headboard to the leech position of MGM. 

MGT : Maximum Girth Top : The leech position for MGT is obtained by folding the front of the 

headboard to the leech position of MGU. 

 

MGL : Maximum Girth Lower : The leech position for MGL is obtained by folding the clew to the 

leech position of MGM. 

The luff position for each girth depends upon which of the following two icons is selected : 

Take the minimum distance to the luff.  This is the standard IMS method. 

Use the luff position obtained by folding the sail on the luff in the same way as 

for the leech.  For example, MGM will go to exactly half way along the luff. 
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Girths 

The values on the left of the dialogue (IMS max. column) are the maximum allowable IMS 

girths based on P and E.  If you want to see the calculations this version of ProSail is 

performing, go back to the batten window and click on the About IMS button. 

The values in the centre (Desired max. column) are the maximum girth you want to allow.   

i.e. This is the envelope that you allow.   They can be expressed either in units   e.g. mm or as 

a percentage of the IMS max.  If you are making an IMS sail you can specify 100%. 

The values on the right (safety column) are the difference between the maximum girth you 

have allowed and the actual girths across the mould you have designed.   If the value is 

positive it means your mould is smaller than the maximum girth you have allowed.  i.e. you are 

safely within the specified girth.  If it is negative then your mould is larger than the girth you 

have allowed. 

 

If you click on the Enforce button, ProSail will enlarge or reduce the roach curve uniformly 

until one of the girths has reached the Desired max. you have specified and all the other 

girths (which have been ticked) are smaller than their Desired max.  If you are not interested 

in all of the girths, simply remove the tick next to the girths you are not interested in.   For 

example if you are only interested in MGM, make sure only MGM has a tick next to it.  After 

clicking on the Enforce button, MGM should then be equal to the Desired max. you have 

specified. 

 

NOTE : It is important to enforce girths (if specified) before panel development if changes have 

been made to the mould since the girths around the mould will have changed. 
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Panel Development 

The Turnover dialogue will appear next : 

To develop the current sail into panels, either select New from the Panel menu to create a 

new panel layout or select Open from the Panel menu to use an existing panel layout. 

 (i) If New is selected, the following Panel Layout dialogue will appear (This is the 

method to use when first learning to use the program): 

Double click on the layout you want.  

Note that all these panel layouts are 

for both headsails, mainsails, 

gennakers and gaffs regardless of 

whether the icon looks like a 

headsail or mainsail. 

Specify the extra seam allowances you want around the sail for turnovers.  These seams are 

added to the sail dimensions entered in the Dimensions dialogue.  If you don’t want any, just 

set everything to zero.  In the case of a high aspect ratio Gaff sail, the luff and gaff turnover 

are the same.  Inner seams are lines drawn inside the sail dimensions. 



43 ProSail 

Panel Development 

Cross-cut & Fan-cut 

If the cross-cut icon is selected, the seam lines will be at 90 degrees to the head-

clew line if Rotate head and Rotate foot are set to 0. 

If the fan-cut icon is selected, the seam lines will be at 90 degrees to the actual 

leech curve if Rotate head and Rotate foot are set to 0. 

Rotate head and Rotate foot : If non-zero values are specified, each seam is gradually 

rotated between the Rotate head angle and Rotate foot angle going from the head 

down to the Ref Seam.   These angles can be -ve if desired.  This method can be used for 

example to make the seams parallel to the foot. 

Panels are generated from the head down to approximately the Ref. Seam location.  The 

panels are shaped on the top side and straight on the bottom side.  The Ref. Seam is only 

an approximation since ProSail generates panels from the head down, it can only 

approximate where the last panel will come. 
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These two icons determine how the panels below the Ref. Seam location are 

developed : 

If selected, ProSail will first generate cross-cut panels down to 

approximately the Ref. Seam location and display the Twist Seam 

dialogue described on the following page for specifying the seams 

below the Ref. Seam.   

For a high clew sail, Ref. Seam must be sufficiently large to prevent 

the last cross-cut panel from going below the clew. 

If selected ProSail will continue developing parallel panels below the 

Ref. Seam location.  

If Shelf Foot is selected, ProSail will add a lens panel at the foot of the sail : 

The top of this lens panel will be shaped so it joins to the panel above.  NOTE that 

this shape will not necessarily be exactly the same as the foot chord shape since the 

seam line for the panel above will not lie exactly on this chord line.  However the 

bottom of this lens panel will be equal to the foot round you specified in the shaping 

window. 

Panel Development 
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Twist seams 

The following Twist Seam dialogue will be displayed after either : 

     (i) selecting the above icon in the Panel Layout dialogue.  In this case the entire sail will 

be drawn in this dialogue.  See the lower next page. 

or (ii) the last cross-cut panel has been generated using the cross-cut panel layout with 

selected (see previous page).  In this case the remainder of the sail below the Ref. 

Seam is drawn in this dialogue as follows : 

With this dialogue you can add seams at any location and at any angle.  Luff and Leech 

are the distance up the luff and leech for the currently highlighted seam.  These are 

displayed in absolute distance or as a %.  The currently highlighted seam is the one that is 

drawn as a dark line.  To highlight another seam, click the mouse near that seam line.  

Note that the very top seam can also be highlighted. 

Adds another seam.  A useful feature of add is that the position of the seam 

it adds is exactly half way between the currently highlighted seam and the 

seam below. 

Deletes the currently highlighted seam.  If you do not want any seams 

below the Ref. Seam (i.e. just have one panel) delete all seams. 

Makes all the seams evenly spaced up the luff and leech. 

Panel Development 
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Orientation : 

Top of panel is parallel with the fabric.   Most common method. 

The panel below the currently highlighted seam can be rotated in three different ways on 

the fabric depending upon the following icons : 

Centre of panel is parallel with the fabric. 

Bottom of panel is parallel with the fabric.   Sometimes used for the foot 

panel. 

Note that the above orientations only apply to the currently highlighted seam.   If you want to 

change the orientation of all the seams, you need to select each seam in turn selecting the 

appropriate icon.  Note that the top seam can also be selected. 

First the following dialogue will appear where the fabric width 

field is used as a check to see that the resulting panels do not 

exceed this limit.   Usually this is not important and so a large 

value is entered.  Note that it does not make panels to this 

width, it only serves as a check.   

Next the Twist Seam dialogue will appear showing the entire 

sail.  If the sail has battens, there will also be a battens button. 

If you selected this icon in the Panel Layout dialogue rather than doing cross-cut 

panels, the entire sail will be drawn in the Twist Seam dialogue.   This method is 

used if you want to create a sail with :  

(i) Only a few horizontal shape seams for use with PatternMaker. 

(ii) For placing seams on batten locations.  e.g. for a Catamaran sail. 

Replaces the current twist seams (if any) with 

seams which lie on batten locations.  The 

seam will be placed at distance below 

batten. 

If desired you can then add seams between 

battens using the Add button. 

Panel Development 
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Horizontal Interface 

Specify the interface seam using a distance down from the head for both the 

luff and leech. 

Specify the interface seam using a distance down from the head for the luff and 

at 90 degrees to the head-clew line. 

Place the interface seam width on the upper panels. 

Place the interface seam width on the lower panels. 

ProSail will generate interface seams so they are almost straight.   Most of  the shape will 

come from the panels themselves (This is probably the opposite of what you did on the 

floor where the horizontal seams were shaped and the panels flat).  However the small 

amount of shape produced in the interface seam is important and should not be removed.  

The same applies to vertical interface seams. 

Specify the interface seam using a distance down the head-clew line and at 90 

degrees to the head-clew line. 

Panel Development 



48 ProSail 

Vertical Interface 

Specify the distance (absolute or %) from the leech for the top of the interface 

seam. 

Line up the top of the interface seam with seams above (i.e. head or vertical 

panel seams).   

The top of the interface can be moved with the mouse.  Click the mouse on the 

top of the interface seam line drawn in this dialogue and with the mouse button 

still down, drag it horizontally to the desired location. 

Place the interface seam width on the radial-tack panels. 

Place the interface seam width on the radial-clew panels. 

Lower Distance along the foot from the clew. 

Upper Distance along the horizontal interface from the leech. 

tack A special case occurs when this is selected.  The horizontal interface seam will 

pass through the tack.  This seam will correspond to the seam on the last tack 

panel.  Because of this, tack panels will be generated before clew panels. 

Panel Development 



49 ProSail 

Radial-Head panels 

Panels are developed based on Number and ratio.  They are developed from the leech to 

the luff where ratio determines how the edge width of the panels change : 

ratio = luff / leech as a % 

leech : Edge width of the leech panel.   This does not 

include the seam allowance or shaping. 

luff : Edge width of the luff panel.   This does not include 

the seam allowance or shaping. 

NOTE : Fabric Width is not used to generate the panel size since panel size is totally 

defined by Number and ratio.  However it is used after the panel has been generated as 

a test to see if the panel has exceeded this size.  If it has, a warning message will be 

displayed. 

Angle Limit is similar to Fabric Width in that it is only a test to see if the angle of the 

panel (measured near the head) has exceeded this angle.  This is useful for some fabrics 

where you might not want to exceed say 6 degrees for example.  If you are not worried 

about angle, specify a large value. e.g. 30. 

Panel Development 
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Orientation defines the orientation of all the head panels on the fabric.  The left icon 

corresponds to the edge of the fabric being parallel with the leech. 

Ratio is useful for smoothly changing panel widths.   However when a sudden change in panel 

width is required, tick reduce : 

Reduce splits the head panels into regions.  The value specified for reduce is the length of the 

region either as a % of the horizontal interface seam or in absolute length.  As well as 

specifying a value for reduce, you can also click on the end of this reducing line and drag it to 

the required location along the horizontal interface.  

Head reduce relates to the width at the headboard.  Within this region the panels are defined 

using Number and ratio.  Once this region has been generated the radial head dialogue will be 

displayed again for the remainder of the head.   If desired this can be split again using reduce. 

Panel Development 
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To enable development of radial-head panels for sails with a large headboard, radial 

head panels can spread down the leech. 

Head panels down the leech 

After entering the head panel dialogue click on this icon :  

Along head is the distance along the head from the leech defining the region of head 

panels that intersect the leech.    

The reduce check box can be used to further reduce this region.  This can be useful 

for defining panels individually for example.  As well as specifying a distance down the 

leech you can also click on the end of this line and drag it to the required location down 

the leech.   

Double clicking on the window title bar will make the window full screen if you want a 

closer look.  Double click again to reduce its size. 

 

Important notes : 

1) The position of these seam lines down the leech will not be exact since after 

panel development ProSail needs to trim the panels to allow for hollow between 

the battens.  This will usually cut into the generated panels however sometimes it 

can actually enlarge them slightly. This will move the leech seam lines up or 

down the leech slightly.  

2) Some older versions of ProSail will not be able to correctly read panel 

configuration files saved (save from the Panel menu) if some head panels are 

spread down the leech. 

Panel Development 
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Radial-Clew panels 

To make these panel seams line up with the seams above, use the same Number and 

ratio as the panels above. 

Radial-Clew panels are specified in a similar way to Radial-Head panels except in two 

sections.  The first section defines the panels that touch the horizontal interface seam. 

If selected, panels will be generated right to the end. 

If selected, panels will stop short of the end.  This allows the next panel to straddle 

the corner.  This is commonly used if the next panels are to be made to the full 

fabric width. 

end If zero, the panels will all terminate at the clew.  If non-zero, the clew end of the 

panels will have a width equal to this value (excluding the seam width).  i.e. they 

will radiate along the foot. 

Panel Development 



53 ProSail 

The next section defines the clew panels that touch the luff or vertical interface seam : 

If selected, panels are developed so their edge width is defined by Number and 

ratio as described previously.  This method is often used when a sail has a vertical 

interface seam to allow the tack and clew panels to line-up across the seam. 

If selected, panels are developed to either their full Fabric Width or to their full 

Angle Limit whichever is the most limiting.  If angle is not important, specify a 

large Angle Limit.  This method is often used when the clew panels terminate on 

the luff (e.g. c-cut layout) and the first clew panel on the luff straddles the luff and 

horizontal interface. 

Panel Development 
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Radial-Tack panels 

Radial-Tack panels are specified in a similar way to the Radial-Clew panels.  The first 

section of panels are from the luff to the vertical interface.  The second section to the foot.  

To make the tack and clew panels line-up across the vertical interface, specify the same 

Number and ratio.  When joining the tack and clew panels together at the join between 

the horizontal and vertical interfaces be careful to join them in the following way : 

Normally clew panels are developed before tack panels.  However the reverse is true if the 

tack check box has been ticked in the Vertical Interface dialogue. 

Panel Development 
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Centre cross-cut panels 

If a panel layout requires cross-cut panels in the centre (e.g. for a tri-radial panel layout), 

the following dialogue will appear : 

Specify the number of panels required.  The panels will be generated at 90 degrees to the 

head-clew so it is recommended that the horizontal interface generated previously should 

also be at 90 degrees to the head-clew.  Be careful not to specify more panels than can 

be generated in the sail. 

Radial-Head with cross-cut panels sail 

This panel layout is done in two steps.  First the sail is developed as if it was a totally 

cross-cut sail.  After the cross-cut panels and twist panels have been developed, the 

following dialogue will appear : 

Click the mouse on the seam where you want the base of the radial-head panels to go 

and that seam will be highlighted.  Select OK and the radial-head dialogue will appear.  

Specify the head panels required and ProSail will replace the upper cross-cut panels with 

these radial-head panels. 

Panel Development 
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Mid-Vertical panels 

Vertical panels in the middle of the sail are specified using two sets of Number and 

ratio : 

The top set define the seams on the upper interface.  The bottom set define the seams on 

the lower interface. 

ratio = luff / leech as a % 

ratio = luff / leech as a % 

Panel Development 
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Vertical-cut sail 

If the entire sail is to be developed into vertical panels the following dialogue is used : 

Panels are developed to the specified Fabric Width - Seam Width starting from the 

leech. 

Spikes If ticked, you can enter the number of panels you want in a spike.  To change the 

position of the spike, click the mouse in the picture where the top of the spike is to 

go. 

Panel Development 
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Mitre-Cut (Extra module) 

The above dialogue specifies the location of the mitre-seam.  The seam is found by 

bisecting the angle between the Head-Clew and Tack-Clew lines.  It is then adjusted by the 

specified Adjust Mitre distance up the luff.  The greater the Adjust Mitre value the 

further up the luff the mitre seam will go and correspondingly the narrower the vertical 

panels in the foot will become.  It is usually necessary to specify a value greater than zero 

(1% is typical) to prevent the vertical panel widths from exceeding the horizontal fabric 

width since often there is more shape in the vertical panels.  

As well as moving the mitre-seam up the luff, Adjust Mitre also rotates the bottom of the 

vertical panels toward the clew slightly to further help reduce the width of the vertical 

panels. 

If during panel development you are warned that the vertical panels exceed the fabric 

width you will need to re-generate the panels increasing Adjust Mitre. 

Note : For low aspect ratio gaff sails the mitre-seam can not go above the gaff corner. 

Cross-cut and vertical seams will lineup across the 

mitre-cut. 

Panel Development 

For Mitre-cut sails the Ref Seam refers to 

the height above the luff location of the 

mitre seam. 
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Panel Development (The method used by ProSail) 

ProSail develops panels so they have one straight edge.  To do this it must find where the 

seam lies over the 3D mould so it results in a 2D panel with a straight edge.  ProSail first 

takes a guess where this seam lies on the 3D mould.  Then using trigonometry, the resulting 

2D panel is calculated : 

However, this 2D panel will not have a straight edge.  Hence ProSail needs to modify the 

seam on the 3D mould to get a straighter edge on the 2D panel : 

This process is continued until ProSail has generated the 2D panel with an edge that is within 

0.1mm of being perfectly straight.  In some cases ProSail will have difficulty achieving this.  

If after trying 10 times, ProSail has failed to achieve this, it will display a message telling you 

how close it has got : 

3D to 2D 

3D to 2D 

Panel Development 
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If this happens, select Yes and ProSail will keep trying.  If the message is displayed again, 

and the value has not reduced, then ProSail is probably unable to generate that panel : 

If during panel development, a panel exceeds either its Fabric Width or Angle Limit, a 

warning message will be displayed. 

Saving Panel Layout Files 

Once a sail has been completely developed, the information entered into the panel, interface 

and turnover dialogues (e.g. seam widths etc) can be saved to disk for later use by selecting 

Save or Save As from Panel menu.  Then the next time you develop panels with that 

configuration on any sail, instead of selecting New, select Open from Panel menu.  This is 

more efficient than selecting New since you can save the seam widths etc that you normally 

use. 

This sometimes happens with the clew panel on the 

leech of a sail with a lot of leech hollow.  This is 

because the hollow is so great that it completely 

cuts into the panel. 

Panel Development 



61 ProSail 

Panel Preferences 

Select Preferences from the Panel menu : 

Clip radial seams On radial panels, seams can produce a large spike unless they are 

clipped.  Hence it is common to clip them. 

Panel Development 

Remove inflexions Replaces panel inflexions during panel development with a 

straight section : 

All mould programs can produce panels which have inflexions in them.  This can 

occur near the tack and clew and is most severe when there is a large change of 

depth for example in Dinghy sails.  Although it may appear odd, it is in fact the 

correct development of the mould which tries to blend smoothly into the corners 

which cause it to inflect.  Most Sailmakers choose to remove these inflexions by 

making sure Remove Inflexions is selected which will replace the inverted part of 

the curves with a straight line.  The only problem with doing this is that because it 

changes the angle on the corners of the panel, the luff and leech curves may come 

out slightly unfair near the foot. 



62 ProSail 

Internal marks for battens As a batten crosses a radial panel, the plotter will mark a 

cross on the panel where the batten enters and leaves. 

inner seams change with 

turnovers 

In the Turnover dialogue, the inner turnover seams will 

automatically be set equal to the specified outer turnover 

seams. 

Panel Development 

Seams on both sides for 

Gennakers 

All gennaker panels will have seams on both sides.  The 

exception to this rule will be at interface seams where only 

the selected side will have a seam. 
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Eyelets/2-Ply 

Eyelets from the Panel menu : 

To select a Reef, click near the desired Reef.  It will then be highlighted and its 

information will be displayed to the left. 

Displays the following dialogue where 3 different types of items can be 

added to the sail. 

Remove the currently selected Reef. 

Zoom the sail picture in the standard way as described in the Viewing 

chapter of this manual. 

Adds a reef. 

Adds a single eyelet.  Also useful as a mark. 

Adds a dividing line (see next page) 

Eyelets 
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Eyelets/2-Ply 

ignore line : Line is totally ignored.  This is used if you want to keep the 

information about the line so it can be used later. 

plot line : The line will be drawn by the pen on the panels. 

divide layer-step (1st layer) : The panels will be divided along this line.   

Joining the luff and leech panels will give the full width of the sail.  The specified 

seam will be placed on the luff panels.  However if seam is -ve, it will be placed 

on the leech panels.  (NOTE : for this to work you must have the PanelMaker 

module). 

add layer to leech (2nd layer) : The leech panels will be the same as divide 

layer-step but the luff panels will be the full length of the sail.   Hence the 

leech of the sail will be 2 ply.  (NOTE : for this to work you must have the 

PanelMaker module). 

Down luff/down leech is the position of the line measured down from the head.  Along 

foot is the foot position of the line measured from the clew.  If curve is +ve the line will 

curve towards the luff.   If -ve, towards the leech. 

The type of line depends upon which of the following is selected : 

Dividing Lines 

Dividing line intersects the leech. 

Dividing line intersects the luff. 
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View Panels 

The offset numbers correspond to 0, 25, 50, 75 and 100% locations. 

To specify the way the panel offsets are displayed, click on the Pref button to display the 

following : 

Select panels from the Window menu. 

Loops through 

all the panels. 

Visually exaggerates panel curves for ease of viewing. 

Offsets are measured up from a flat line between the ends.  Most common. 

Does not include seam allowance. 

Offsets are NOT measured up from a flat line between the ends.   They are 

measured down from the maximum depth point on the curve.  The following 

2 icons determine whether this includes the seam allowance.  

Includes seam allowance. 
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You can either select a colour by clicking in one of the boxes under the heading Basic Colors 

or under the heading Custom Colors.  Click Ok to leave the dialogue.  Or you can define (and 

store) your own custom colours. 

To define your own custom colours : 

1) First click in one of the empty boxes under the heading Custom Colors.  This is where 

your custom colour will be stored.  It is important to click here before defining the colour 

otherwise it will by default be stored in the first location which might overwrite one of 

your previously stored colours.  Very annoying. 

2) Then click the closest colour to the colour you want in one of the colours under the 

heading Basic Colors.  Alternatively you can click on the large rainbow coloured square 

in the right half of the dialogue. 

3) You can then modify the colour using the controls on the right half of the dialogue.   The 

far right vertical scroll bar is useful for specifying luminosity (intensity).  Red, Green, Blue 

give the relative mix of each of these colours that creates the resulting colour.  These 

vary between 0 and 255 and you can enter them directly if you wish.  The colour black 

corresponds to Red, Green, Blue all being 0.   White corresponds to them all being 255.   

4) Once you are happy with your colour, click on Add Custom Colors to add this colour to 

the original position you selected at point 1).  Click Ok to leave the dialogue. 

Select Colour Panels from the Window menu: 

Click on the large New Colour button to display the following : 

Colour Panels 
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To make a panel the same colour as the New Colour button (current colour), simply click in 

that panel.   Do this for all the panels you want to make that colour.   You can also click (and 

with the mouse button still down) drag a selection rectangle across multiple panels.  All the 

panels that intersect that rectangle will become that colour. 

To make all the panels the current colour click the make all button. 

To make the current colour the same colour as one of the panels, first click the Copy Colour 

button and then click on that panel. 

At any stage if you make a mistake you can click the Undo button.  Undo can be used as many 

times as required. 

Colour Panels 
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After developing panels you can define patches (if this module is present) by selecting Patches 

from the Window menu.  This will display a picture of the sail in the left half of the window 

with its panels and any patches it may have. 

The right half of the window shows the current corner of the sail we are looking at.   To look at 

another corner of the sail click the mouse near that corner in the picture of the sail.   

The name of the corner and the number of patches it has will be displayed at the centre top of 

the window.  In the example below we are looking at the Clew Patches and there are 2 of 

them :  

The first time you 

enter this dialogue 

there will be no 

picture to the right.  

Namely no patches.  

To specify clew 

patches, click on a 

number next to 

Clew Patches.   

Patches (Extra module) 

Clew Patches : Number of clew patches.  They are all the same shape but different sizes. 

foot : Distance along the foot of the 1st (largest) patch. 

leech : Distance along the leech of the 1st (largest) patch. 

curved : Ticked if the patches are curved. 

Orientate :  Specifies the fabric orientation of the patches used when nesting.  If you 

are not happy with luff, head-clew or leech orientation, you can select 

other.  If other is selected, a small lever will appear with a control point 

on the end of it.  This control point can be dragged with the mouse to 

define the thread line direction. 

Control points : Specifies the number of small red control points the 1st patch has around 

it.  These points can be dragged with the mouse.  If curved is ticked, 

these control points will not lay on the patch but will influence it.  The 

more points, the more control you have over the shape of the patch 

however the more difficult it is to produce a nice looking shape. 
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Clicking one of these buttons will display the following 

dialogue for the corresponding patch number : 
...... 

number : Number of strips in that patch. 

overlap : The overlap seam on the perimeter of 

the patch. 

Eyelet radius : How far from the corner of the sail the 

centreline of the strips will pass. 

taper : % of seam taper.  0% means the strips 

will be parallel.  100% means the strips 

will narrow at the corner of the sail to a 

width equal to twice the Eyelet radius. 

1) If fan is selected the following information can be specified : 

2) If plain is selected the patch will be made from one piece of fabric. 

3) If radial is selected the patch will be made up of radial strips which exactly lay on top of 

the radial panels in that corner.   This option is only available if you also have the 

PanelMaker module. 

To define the other patches for that sail corner click on the corresponding button : 1st, 2nd 

etc.  Each patch can be defined differently.  For example a plain patch can be placed over a fan 

patch. 

To the right of the patches corresponding button will be a %.  This is the size of the patch as a 

% of the size of the 1st patch. 

The information defining patches is saved in the Patch files.  These files are handled using the 

Open, Save and Save As menu items under the File menu in this patch screen.  Note : 

Patches are not saved with the sail mould.  Like panel files, panel layout files and fabric files, 

they are saved separately from the mould.  The advantage being you can load patch files 

generated on one mould for use on another mould.  They will of course be slightly different 

since they need to adjust for the change in angles from one sail to another. 

Patches (Extra module) 
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Enter the desired fabric width to be used.   See the PanelMaker & Nesting manual for details. 

Nesting 

After developing panels, select Nesting from the Window menu to take the panels to the 
nesting window. 

Click New panels to take the developed panels to the nesting window.  If you click No, the 

panels on the nesting window (if any) will not change. 

If the sail has patches, tick Generate Patches to have these patches added to the end of the 

nested panels. 

If any patches are of the Plain patch type, click on warp or fill to select which way you want 

the panels orientated on the cloth. 

If Mark base patches is ticked, the largest Plain patch in each corner of the sail will have the 

location of its smaller patches marked on it.  This can help in sewing the different layers of 

patches together. 

IMPORTANT : If go back to the 3D viewing window and redevelop panels, you have to select 

Nesting from the Window menu again to load these new panels on to the nesting screen.   If 

you just click on the nesting window to bring it to the front, it will still have the previous panels 

on it. 
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PatternMaker (Extra module) 

With PatternMaker you can take a set of cross-cut panels comprising a sail and cut them up 

into radial panels of any complexity using a pattern. 

Once a pattern is defined for one sail it can quickly be superimposed onto any other set of cross

-cut panels from other sails. 

This method differs from conventional mould design since all the shape comes from the 

horizontal seams.  The radial seams have no shape. 

The advantages are : 

1) Shorter design times. 

2) Shorter manufacturing times since it is easier to stick straight seams together. 

3) Sails are easier to repair. 

4) More accurate assembly particularly for large sails with a lot of seams. 

 

This method however is not suitable for small sails with few seams.  

To enter PatternMaker, develop the sail with some cross-cut panels.  The entire sail does not 

need to be cross-cut panels.  For example you could use these panel layouts : 

......... 

Then select PatternMaker from the Window menu.   This will take any cross-cut panels to 

PatternMaker : 
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PatternMaker (Extra module) 

The cross-cut panels are automatically joined together 

so that the centre of the top side of one panel is inline 

with the centre of the bottom side of the panel above.  

The distance between them at their closest point is 

equal to the bottom panel’s seam width. 

This forms a closed boundary that a pattern may be 

placed over.  Initially the boundary contains as many 

regions as there are cross-cut panels. 

Within each region we can define a pattern : 

(i) First highlight the region by clicking in it.  The highlighted region will have small squares 

drawn on its corners (see previous page). 

(ii) Click in  

(iii) Click the mouse 4 times at desired locations on the region.  These locations define 

the edges of the resultant panels.  The first and second clicks define one edge of the panels.  

The third and fourth clicks define the other edge of the panels.  Note that the order in which 

the panels are developed is also determined.  See the examples below : 

The pattern can be changed at any time by clicking in the icon again and re-doing the 4 clicks. 
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PatternMaker (Extra module) 

To alter the definition of a pattern in a region, double click the mouse inside the region (A 

pattern must be defined before you can do this) to display the pattern dialogue : 

Generate parallel panels based on fabric width. 

Generate the specified number of panels where the edge width of each panel is 

defined by ratio.  This method is useful if you wish to line-up panels across an 

interface. 

Generate the specified number of panels where the angle of each panel is defined by 

ratio.  This method is sometimes useful for radial panels. 

Based on width Based on angle 

In the text field you can enter up to 3 letters.   These letters will be plotted next to the panel 

number for all panels in that region.  Because of the room it requires on the screen, you will 

only see the text in the first panel within the region on the screen display. 
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Interfaces are used to divide one region into two.  To create a new interface : 

(i) Highlight the desired region. 

(ii) Click in  

(iii) Click the mouse outside the highlighted region and while holding the mouse down, drag the 

resultant line across the highlighted panel. 

When the mouse is released, the region will be divided along that line.  The ends of this 

interface line can later be dragged with the mouse (see note below).  To specify more detail for 

the interface, double click in the middle of the line to display the following : 

PatternMaker (Extra module) 

Locate the highlighted end of the interface using position. 

Locate the highlighted end of the interface by lining it up with seams or interfaces in 

neighbouring regions.  Note that if the pattern in the neighbouring region is later 

changed, this interface will move to whichever becomes the closest seam or interface. 

Defines which side of the interface the seam width is placed.  Click 

on the desired side. 

To highlight an end of the interface seam, click near it.  A small square will appear on that end. 

Note : The ends of the interface can also be dragged (both in this dialogue and on the full 

PatternMaker screen).  Note that the mouse must be released outside the region so the 

resultant line cuts through the region.  
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PatternMaker (Extra module) 

If some regions corresponding to cross-cut panels have been removed, you will have some 

choice as to where to place the border between the regions.  To move a border : 

(i) Click the mouse very close to the border. 

(ii) With the mouse still down, drag the resulting line to its new position. 

Panels 5 to 8 should be sewn together using this straight reference edge as a guide (compare it 

to a straight line on the floor).  This straight edge is there solely for this purpose and allows a 

sail to be sewn together very accurately.  It can be cut off later. 

To generate panels from PatternMaker, select Nesting from the Window menu.  When the 

panels are plotted, an extra reference line will be drawn at interface seams : 
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To remove an interface (or to combine two regions into one larger region) : 

(i) Click on the interface (or one of the regions) to highlight it. 

(ii) Click in  

PatternMaker (Extra module) 

To reorder panel numbering : 

(i) Click on this icon 

(ii) Then click in each region starting with the region you want to have the largest panel 

numbers.  Keep clicking in all regions until you finally click in the region you want to have the 

smallest panel numbers. 

(iii) To finish, click the mouse anywhere other than in a region (for example an empty part of 

the screen). 

The screen can be zoomed in the normal way.   To unzoom click in this icon :  

New, Open, Save and Save As from the File menu relate to the 

Pattern file containing everything defined in PatternMaker. 

Open from the Slash menu will open the cross-cut panels the 

pattern is placed over.   Initially when you enter PatternMaker from 

ProSail it will take cross-cut panels from the ProSail mould into 

PatternMaker.  However you can select other cross-cut panels you 

want the pattern placed over by selecting Open from the Slash 

menu. 

seam width from the Slash menu : 

Panel Seams is the seam width on the pattern generated seams. 

Default divide Seams is the default seam width used on 

interface seams.  You can later change these individually in the 

interface dialogues. 
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File 

 New  : Create a new sail mould file. 

 Open Ctrl O : Open an existing mould file. 

 Save Ctrl S : Save the changes made to the current mould. 

 Save As.  : Save the current mould with a new name. 

 Units  : Displays the Units preferences dialogue. 

 …………… 

 Zoom Ctrl Z : Zoom in. 

 …………… 

 Preferences  : Displays the general preferences dialogue. 

 ...............  

 Quit Ctrl Q : Leave ProSail. 

 

Mould 

 Shaping Ctrl F : Displays the Shaping window. 

 Battens Ctrl B : Displays the Chord window. 

 Dimensions Ctrl D : Displays the Dimensions dialogue. 

 ...............  

 Rescale Ctrl R : Force ProSail to rescale the mould (ProSail does this automatically 
before panel development). 

 Area  : Calculates the sail area around the mould including the foot 
round. 

Panel 

 New Ctrl P : Display the Panel Layout dialogue for developing panels. 

 Open Ctrl W : Open a previously saved Panel Layout and develop panels. 

 Save  : Save the current panel Layout. 

 Save As.  : Save the current Panel Layout with a new name. 

 ...............  

 Eyelets Ctrl E : Displays the Eyelets/2-Ply window. 

 Preferences  : Display the Panel Preferences dialogue. 

 Show numbers : Show or Hide panel numbering on the panels.  

 

Window 

 Chords Ctrl C : Display the Chord window. 

 Girths Ctrl G : Enter the Girths window. 

 Panels Ctrl A : Display the panel window. 

 Patches  : Display the Patches window. 

 Colour Panels  : Enter the Panel Colouring window. 

 PatternMaker  : Display the PatternMaker window. 

 Nesting Ctrl N : Enter the Nesting window. 

 

Menus 
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View  

 Animate F1 : Animate view. 

 ...............  

 Toolbox  : Display lighting toolbox 

 Light from  : Change light direction 

 Next view F2 : Loop through the stored views. 

 Show scrollbars : Show or Hide the viewing scroll bars 

 

Print  

 Dimensions  : Display the sail dimensions for sending to the printer. 

 Offsets  : Display the panel offsets for sending to the printer. 

 ...............  

 Screen  : Prints the screen. 

 

About 

 About  : Display information about software version etc. 

 Bug Report  : Creates a problem report file that can be e-mailed to Armstong-
White Automation for problem support. 

Menus 


